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Pl System Analytics — Fit for Purpose

ABSTRACT

Attend this talk as we cover scenarios to illustrate the different levels
of analytics that are fit-for-purpose when using the Pl System - for
example, what calculations and analysis do you do in AF, when do
you use MATLAB for advanced calculations that hook into AF and
when do you call on “data science and machine learning ".

Use cases will focus on equipment i.e. pump or motor or compressor
etc. as well as on a process.
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Layers of Analytics — View Thru’ Multiple Lenses

* Functional Scope - Process Insight & Excellence
» Descriptive, diagnostic, predictive, prescriptive

- Business Scope - |mproved Reliability
» Usage-based Maintenance - UbM

* Condition-based Maintenance - CbM

» Predictive Maintenance — PdM
» Simple predictive (Advanced CbM)
* Advanced predictive - Statistical, Machine learning...

 Architectural Location
* Edge device, Server or cloud based
 Analytics during data collection?
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Layers of Analytics - Process Operations
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Layers of Analytics - Maintenance & Reliability

EffectiAveness Predictive
Simple

Advanced (Machine

Learning)
Condition-based

Continuous
Automated Readings
Instrumented  Aytomated Analysis

Oberator Rotnds Automated Readings
Manual Readings M2nual Analysis Predicted maintenance

Manual Analysis (Pd M )

Preventative

Calendar-based
Runtime-based

Efficiency

Condition based maintenance
(CbM)

Reactive

“Break-Fix"”
Run-to-failure

Usage based maintenance
(UbM)
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Layers of Analytics — View Thru’ Multiple Lenses

 Functional Scope - Process Insight & Excellence
» Descriptive, diagnostic, predictive, prescriptive
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Descriptive AnalyticS — PiI Asset Analytics

Calculation Steps:

[ ] C . I I t - f Cold fluid in Shell ' Qot_rﬂuid out o .
w.t s ! S
Onf /gure caiculations r1or 1 DU Qo b s
e Qs = W X Cpe X (t6-1;)/1000/3600
»

¥

Hot Fluid Pressure Drop. AP = P; — P,

transparency and scale -

3. Cold fluid pressure drop. AP¢ = pi- po

-
. : T
* Math, statistical, and time-based S. Temperanure range cold uid. A=,

. Heat Exchanger Key Performance Indicator: 6. Capacity ratio. R =W X Cpn/ W X Cpe (0r) (Ti- To) / (to- 1)
fu n Ct I O n S Overall heat transfer coefficient 7. Effectiveness. S = (to- ) / (T; — tp)
8. LMTD
Q LMTD Counter current Flow = ((Ti=ts) — (To=t:)) / In ((Ti=t)/(To-t))

Hot fluid in 4. Temperature range hot fluid. AT = T;- T,

Baffles
W. T

Cold fluid out J|

LMTD Co cwrent Flow = ((Ti-t,) — (To-1)) / In ((Ti-t)/(To-1o))

° I nteg rat i O n Wit h M AT LA B A x corrected LMTD Correction factor (l;:l’L:\;l’:l;Dxl::\(-:(clT\::;:;o:‘(-]:5; not\-

F = -
RULE: IF the heat transfer coefficient is decreasing, (1-R)xIn {%QAL:L—.W}
-~ _THEN the Heat Exchanger EQULING 111 2RI ERATY
=2 i i 7 “orTect: =F x
. . d . I . . f gd;?:ﬂr”nmés regqi “1[ | | : Corrected LIVITIT - F x LMTD fcng
e & | Nme Scheckie Outputls) Descrption:
Iestlng and operationalization o Tl e, l
E g wmxm T Overall Hest v y Hea Categories: | HeatExchangerCalcs. -
. . . ©- G Custody Transfer Analysis Type: = Bxpression  Rollup  (~ Event Frame Generation
— G Fractonstor
redictive analysis models e
G Heat Exchanges Templat
£ Heat Exchanger Tempiat
B (g Heater
gmkmmrs )| o] [t
£ Irouts Name Expresson Value | Insert
., . .o . 4 =
° ondition-based notitication B se - [ ®
G Outputs *'Shell Side Heat Capacity'*3600 | Abs
G Piserver 1 1 1 1 | Acos
e - | “Tube side mass Flow'e"cold side Temperature Difference's Tube Side Heat Capacity'*3600 | i B
G Reactor Q qs+qt | Map ® Asin
Refrenes t ' ' = L am
° S t f t d t f @ oo . N et o S e (R A p e i ]| [ o |
t ‘ : I
upports tuture aata 1or = ; e e e B 5 EM
- g::,m i I ™ re’-"Cold Side Ou - [ I ® ok
um y Side Inlet Temper Lo s .- MTD
fo t G reicene fcota stoe oveler < outiet Teape {6 Siae Taiet Temperature:yys | el
ruck Termnal + t t t »
recas Ing - g umt u ((R$1)0.5"Log((1-5*R)/(1-5)))/((1-R)*Log((2-5 (R+1-(R+1)"0.5))/(2-5* (R+14(R+1)"0.5)))) | Msp ®| EM
& Event Frame Templates T T T 1 ompan
- (5 Model Templates uTDcorr FoLMTD | Map ® | concat
& Notification Templates 't Convert
- 1§ Transfer Templotes u Hax(qs,qt)/("Area’ *UTDcorr) | :mmmuzmveg;ngmm@ Cos
Enumer: Set o - - — Cosh
p ATt e &
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Diagnostic Analytics — Trending and Event Awareness

* Access to operational data in m:;" i

real-time with tools suited to () e
Operations. 1 ;E - s
*F 22 Voltage
- Supports ad hoc, self-service | |
investigation. —aF “

Resid (calc)
181.57

Total VARh Total Wh

CLEBFP1

Outside Air Temperature Main Steam F
25.634 deg F 20.174 Kk Ib/hr

oms Active Thrust

Inner Temp Bearing Metal
86454°C 86 F
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Real-time Data is Different

B A% leakno Bl 4B compute o002 | A% ci B -5 read_locat B % map Bl A& plat B -5 viock Bl 4% date_rep [ -]
. . 7800201621 00201621 5an Jose Under Drway o/m 11/28/2000 14:00:00
o T ransa Ct| ona I d ata IS 3l 7301200081 01200081 Santa Clara ofm in s/ cor of Humbolt Ave 1/5/200111:00.00
E3N 7801200091 01200091 Santa Clara ofm 2' into property 1/4/2001 01:30:00
.
reco rd e d in a t a b u | ar P 7501200121 01200121 Santa Clara ofm, 3 from sidewalk 1/16/2001 10:00-00
W 7201200841 01200841 Santa Clara 1% o/m under concrete pkstrip at e/end of drway 8/27/2001 11:00:00
fo r m at W it h Va I u e S 7801200851 01200851 Santa Clara 1% under drway at curb & Gutter 8/28/2001 10:00:00
(i 7803200121 03200121 San Jose 1575 Parkveiw Ave. 3/23/2003 09:48:00
. t d b | LAl 7803200461 03200461 Santa Clara 1% in svc tee area ofmain 11/10/2003 07:33:00
a SS o C I a e y CO u I I I n S I 7806200241 06200241 Santa Clara s/w cor Princeton Wy x Princeton Ct on main 2/6/2006 13:15:00
— — — -

. 7806200271 06200271 Santa Clara S/E cor Homestead x Lawrence Exwy valve frme&cover 2/72006 11-:40:00
I n e a C h rOW . 7806200351 06200351 Santa Clara OfM @ svc tee (Longside) 2/16/2006 10:00:00

7806200441 06200441 Santa Clara ‘OVer main next to srvc tee 3/8/2006 13:00:00
7806200431 06200481 Santa Clara ‘on main or tee 3/10/2006 09:45:00
7806200491 06200491 Santa Clara ‘on main ovr sewer not venting to house 3/10/2006 10:00:00
[ R e a I _ti m e d ata i S 7806200501 06200501 Santa Clara btwn #s 3145 & 3155 Mauricia Wy on main or tee 3/10/2006 11:25:00
T 7806200511 06200511 Santa Clara on tee 5/0 driveway 3/10/2006 14:00:00
re CO rd e d Wi.th O n | il 7306200541 06200541 Samta Clara ontee 3/15/2006 13:30:00
y 7806200561 06200561 San Jose ‘ovr main btwn Greendale & Auburn on Albany 3/16/2006 13:45:00
. [l 7306200611 06200611 Santa Clara 15' from drway about 15" in parkstrip @svc tee 3/22/2006 13:45:00
tl I I I e C O n teXt, 7806200641 06200641 Santa Clara 3% OVER MAIN NEXT TO SEWER 3/23/2006 14:00:00
. . 7806200651 06200651 San Jose ‘On main or srvc tee 3/24/2006 11:15:00
I . e . Va I u e a n d pral 7806200681 06200681 Santa Clara 5" in parkstrip fr/swk over tee on main &' from... 3/28/2006 13:40:00
7806200701 06200701 Santa Clara 36' EO W p/l Olympus. 2% In water box 3/28/2006 13:00:00

.

‘t| rn esta rn p. 28 7505200711 06200711 Santa Clara F/O ofmain (under tree) 3/29/2006 11:00:00

7806200721 06200721 Santa Clara ofsvc/tee about 3' from drway in parkstrip 3/29/2006 13:10:00

56.902 03-SEP-2016 11:23 AM
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Real-time Data Requires Context

Time
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Real-time Data Requires Context

Asset
Hierarchy

Plant

* Process

* Assets

* Process Context
* Location

* Specifications
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ﬁ Bahrain
= P Crude Unit

....... ﬁ E_E]_UU
.. (§ BE239
i ...... ﬁ E.ES.q.E
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Process
Context

Location

Specifications

Category: Process Data

- &7 Cold Side Inlet Temperature 77.1157989501953 °F
. &F Cold side Qutlet Temperature 131,192291259766 °F
- &7 Hot Side Inlet Temperature 374.601501464844 °F

¥ Hot Side Outlet Temperature 292,926361083984 °F

Category: Location

2] =] Address

2265 W Salinas 5t, 5an ...

2] £] Latitude

29.43027

=] Longitude

-98,518172

1200 ft2

75.66 BTU per F ft2 Hr

Category: Spedfications
o] =] Area
o] =] Coeffident
o] =] Service

#OSIsoftuC  #PIWorld
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Pl AF Provides Context to Real-time Data

Elements | = Transforme
5 Elements
SRl B ow Voltage System Select Data » Modify View > Publish
[=l- [§ Substations
& Palmer = Add Column Y Esiit Row Fiters = Edit Value Mode S (=ri e
B ﬂ Rockefeller 10 columns: @ Raw Filters !::?Ir;ﬁfr:m-e: IS 12.00.00 AM | | VIAG 12-00:00 AM | Apply
B ( Cireit 03
= ﬂ ¥ i Time5t; Circuit Phase Pole Tr Avg_Voltage Max_Vaoltage Min_Voliage Tot_VARh Tot_Wh |"E
B (§ PT 812024305 Palmer 11/1/2015 12:00:...  Circuit 01 x PT 411054401 250.151 250,335 249977 566.962 1,831.385 A
- [ MR-20251537 01 i

» g MR-20251533 LI AR A Cinuitll . B iiaadl, ~R1E SRR AL ERAEET LAl Al
Palmer 11M/2015 12:02...  Circuit 01 X PT 411054401 250,152 250.385 249.977 566.812 1,830.895

- [ MR-20251540 — — — — —

almer 03 ITCur B . 3 o .

. G MR-20251313 Pal TIT2015 12.0 CIrCuit 01 S FT 411054401 290192 250 380 249971 566,138 1,650.60
......  MR-20251814 Palmer 11M/2015 12:04....  Circuit 01 X PT 411054401 250152 250385 249.978 566.663 1,830,405

- [ MR-20251815 Palmer 11M/2015 12:05. Gircuit 01 X BT 411054401 250 152 250 385 249 978 566 588 1,830 160
- [ MR-20251816 Palmer 1112015 12:06:...  Circuit 01 X PT 411054401 250,152 250.385 249.978 566.513 1,829.915

""" 9 MR-20251837 Palmer 11M/2015 12:07-.._  Gircuit 01 X PT 411054401 250152 250,386 249978 566.439 1,629.671
- g :2'3?:3::’: Palmer 11M/2015 12:08....  Circuit 01 X BT 411054401 250,152 250,386 240.978 566.364 1,820,426

. ) MR-20251887 Palmer 11/M/2015 12:09:...  Circuit 01 X PT 411054401 250,152 250.386 249.979 566.289 1,829.181
. () MR-20251909 Palmer 11M/2015 12:10...  Gircuit 01 X PT 411054401 250153 250.386 249.979 566.215 1,528.936

- (P MR-20251910 Palmer 11M/2015 12:1 Circuit 01 X BT 411054401 250153 250.386 249.979 566.140 1,828.691
- ([ MR-20251911 Palmer 11M/2015 12:12:..  Circuit 01 X PT 411054401 250153 250.386 249.979 566.065 1,828.446

- @ :2‘;;2;5 Palmer 111/2015 1213 Circuit 01 x PT 411054401  250.153 250.386 249.979 565.991 1,828.201
""" g MR:2025585 . Palmer 11M/2015 12:14.... Circuit 01 X PT 411054401 250153 250.386 249.980 565.916 1,827.956
) R Palmer 11M/2015 12:15:...  Circuit 01 X PT 411054401 250153 250.387 249.980 565.841 1,827.712

(J MR-20255878
. MR-20266921 Palmer 117112015 12:16:...  Gircuit 01 X PT 411054401 250153 250,387 249.950 565.767 1,827.467
F MR-40195576 Palmer 11/1/2015 12:17-...  Circuit 01 X PT 411054401 250153 250.387 249.980 565.692 1,827.222
PT 812111102 Palmer 1172015 1218 Gircuit 01 X BT 411054401 250 154 250 387 249 980 565 617 1,826 977
Palmer 11/M/2015 12:19:... Circuit 01 X PT 411054401 250.154 250.387 249.981 565.543 1,826.732
Palmer 11M/2015 12:20...  Gircuit 01 X PT 411054401 250.154 250.387 249.951 565.468 1,626.487
X

Palmer 11142015 12:21:...  Circuit 01 PT 411054401 250154 250.387 249921 565.393 1,826.242 W
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Supporting Analytics with Contextualized Data

Real-Time Decision Analysis

Time and Event
Trending & Awareness

Specialized Models

Simulation & Optimization

B APpp = kh
141.2uBg{In:—; -3+

5}

Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

M

ver

(g
af
&
g
El
=
—
—
e
-ll
[~

CCCoCCCoCoC
5555555555

Visual
Dashboards &
Multidimensional Assessment

seeeeeeeeew
ST EEEISEEEE

|Advanced Prediction vs. Actual
i Wik}
Time, Event and Tabular " LAl
Asset Context Context VoA e

Condition & Performance

0OSlsoft.

Descriptive {

Common Ground between Technological

Statistical Modelling
Contexts

& Machine Learning

} Predictive
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Diagnostic Analytics — Multidimensional Visualization, Dashboards

Oil and Gas Operations & swre Dasasoare

Business Analysis

Product inventories Dashboards

Collaboration

Asset Performance Analytics
Benchmarking Measurement
Correlation

OSlsoft.
PI World SAN FRANCISCO 2018 #0OSIsoftUC  #PIWorld  ©2018 OSisoft, LLC



Feed Drying Process - process and Regeneration Cycles
Also see Pl World 2018 Layers
of Analytics Hand-on Lab

* Molecular sieve dryers remove Wet Feed

water from hydrocarbon |
feedstock before entering S = - - ]
Dryer A Dryer B Diryer B;)rg::l;ng Siale
* Proper regeneration is critical

to avoid corrosion in acidic
reaction

T3 9,995 bbld

1 e Dried Feed Moisture Dried Feed

e Cyclic operation between Feed for

Regeneration

Process and Regeneration 500 e
cycles

8 Outlet Temperature

Regnerant Return
>

Hot Gil Return
177 bblid

* Regeneration cycle is
indicated by high be outlet
temperatures

{%1 OSlsoft 15
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Predictive Analytics — Dryer Regeneration Guidance for Operations

Dryer Regenerations

* During Regeneration, monitor
bed Outlet Temperature
against a modeled profile,
notify operator of deviations

* Prepare data using AF Analytics
and Event Frames

factor(bRun)
3% 2
46 —128
47 —129
54 130
60 131

* Publish dataset for model , » —
development and training 4/1972018 12:54:00 PM - 4/19/2018 3:54:00 PM ﬁ"&f’%@'ﬁmﬁ:

bT

* Develop model in R/MATLAB

* Operationalize model using AF ,
Analytics and R/MATLAB

200

|

L
0.5h
4/19/2018 12:54:00 PM 4/19/2018 3:54:00 PM
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Feed Dryer Status — Regeneration Event Frames

AF Analytic defines the
beginning and end of
regeneration cycle

Digital state for each dryer
with Process of Regeneration
states

Start temp. =170 F,
Endtemp=175F

Confirm five hours since last
regeneration to avoid short
cycles caused by initial
temperature fluctuation

Backfill through 2017

7 oslsoft
E‘S‘ Pl\World san rrancisco 2018

If('Outlet Temperature' »>= 'Outlet Temperature|Start of Regeneration Temperature'
And PrevVal('Operating State', '*-5h') = "Process")
Then (If PrevVal('Operating State', '*')="Regeneration"
Then NoOutput()
Else "Regeneration")
Else
(If('Outlet Temperature' <= 'Outlet Temperature|End of Regeneration Temperature'
And PrevVal('Operating State', '*-5h') = "Regeneration")
Then (If Prevval('Operating State','*') ="Process"
Then NoOutput()
Else "Process")
Else NoOutput())

Dryer Regenerations

#0OSIsoftUC  #PIWorld
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Feed Dryer Bed Age — “Dryer Bed Processing Age”

° AF EXpreSSIOn ana|ytIC Dryer Bed Condition - Mol Sieve Age
determines processing age of
molecular sieve desiccant

Dryer A Processing Age

* Enables bed balancing for
maximum service

Dryer B Processing Age

e Calculate Lifetime Total Dried
Feed, converts total volume
from a volumetric rate

* Processing age:

Lifetime Total Dried Feed
Loaded Wt. of Mol. Sieve

If ('Operating State' = "Process"

And Not(BadVal('Process Flow'))

And Not(BadVal(PrevVal('Process Flow','*"))))
Then 'Lifetime Total Dried Feed’ +

TagTot('Process Flow', PreviousProcessFlowTime,"'*")
Else NoOutput()

Backfill through 2017

é 7 osisoft
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Dryer Regeneration — Publishing Summarized Dataset

* Leverage AF model to Select,
Shape and Publish tabular Select Data > Modify View > Publish
VieWS tO a Va riety Of end pOintS ¥4 Source Events %, Search Shape ' Matches

2 oshcurt 3

Server CHERTLER7450 | %, Event Shape ~ ound 52 Matches
. . — 4 ¥4 Dryer Regeneration Cycle SR *# Dryer A Regneration 01-02-17 00:00
° Database Dryers oV yerseg #
Event Views publish Event g ot 2 % 1 Biomensomsncicsnm
1 1 Y | Enter Event name or sting match patte # Avg Outlet Temp Eve nt F rame SR *® Dryer A Regneration 010317 2118
rame data In eitner
. Event Frames Assets & Avg Regen Drum Level Att r| b uteS VS *4 Dryer A Regneration 01-04-17 22:54
SU m marlzed or Sa m pled # AvgRegen Temp % " Dryer A Regneration OR05-17 18:54
@ Diyera & Dryer Processing Age s ¥4 Dryer A Regneration 01-06-17 20:54
St r u Ctu res @ DyerB & Max Outiet Temp e *8 Dryer A Regneration 0107-17 21:06
[=] Max Processed Moisture | ¥4 Dryer A Regneration 0+08-17 22:24
° S a m p I ed Vl eW CO m b | n es @ Max Regen Temp # % | " Dryer ARegneration 0+10-17 03:12
. = % Asset Shape “d Dryer A Regneration OH1117 02:36
aggreg ations taken over the Adtributes | Frer =[] ., Qomra Asset 7% |rioverareemion ot moars
H H O select Al & Dryer Pressure % *3 Dryer A Regneration 013-7 03:00
Event Frame d uratlon Wlth = MOICUaT SIeve Loaoing o Element ; *4 Dryer A Regneration 0144-17 13:30
= & Outlet Temperature £ R ¥ g
Asset data sam pled at |nte rva |S & Operating State e & Regenerant Fow Attrl butes s x |rioveraregrentonomis 724
» § Outlet Temperature ;] ; “4 Dryer AR tion 01617 2142
. & Regenerant Temperature ra Tyer A Regnerstion
throughout the duration pr— o 3O A egrion 417730
§ Regenerant Flow ;] » 4 Dryer A Regneration 01197 02:24
@ Regenerant Retumn Drum Level (:] » " Dryer A Regneration 01-20-17 06:30
& Regenerant Retum Drum Pressure ;] » 4 Drver A Reaneration 01-21-17 1536
‘ Regenerant Temperature e v

OSlsoft.
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Dryer Regeneration - sampled Event Publication

Dryer Time Stamp Duration Elapsed Time Dryer Pressure  Outlet Temperature  Regenerant Flow  Regenerant Tempe Dryer Regeneration Cycle Avg Outlet Temp  Avg Regen Temp  Dryer Processing Age Total Processed Feed
Q ’_ Dryer A 1212017 1220000 AM 53 0 170.4697 436.9 603.2525 496.1 Dryer A Regneration 01-02-17 00:00 319.9179 2297132 0.0005072668 4474.716
E Dryer A 1/2/2017 12:06:00 AM 5.3 6 170.4824 437.8 603.6448 496.2 “« “ “« “ “
E Dryer A 1/2/2017 1212200 AM 53 12 170.495 4386 605.063 496.4 “« “
“« “" “
L - Dryer A 1/2/2017 12:18:00 AM 5.3 18 170.5076 4395 599.6411 496.8
— “ “ “ “" “
. . . . . - .
GCJ N . H : . : : “« “« “« “ “«
. . . . . : :
LI>J “« “« “« “« “«
___|Dryer A 1/2/2017 5:18:00 AM 53 318 204.1571 173.8 314.5962 2879
" Dryer B 1/2/2017 7:00:00 AM 96 0 169.723 170.2 596.6678 480.7 Dryer B Regneration 01-02-17 07:00 357.6974 404.2589 0.05128649 2742.962
E Dryer B 1/2/2017 7:06:00 AM 96 6 170.4792 170.3 598.8013 4848 “« “« “
“ “
© Dryer B 1/2/2017 7:12:00 AM 96 12 171.0217 170.4 597.2024 487.9
— “« “« “« “« “«
'.I.I:' _< . H . . 4 . . “ “« “« « “«
qC) . . H : . : H “« “« “« “« “«
> “« “« “« “« “«
w | Dryer B 1/2/2017 4:36:00 PM 96 576 168.8051 174.9 896.8521 173.8
) Dryer A 1/2/2017 7:00:00 PM 1.3 1] 169.5046 170 596.4086 4256 Dryer A Regneration 01-02-17 19:00 332 5292 364.0818 0.1004348 5302.277
E Dryer A 1/2/2017 7:06:00 PM 1.3 6 170.3642 1701 598.5709 4427 “ “« “ “ “
© Dryer A 1/2/2017 7:12:00 PM 113 12 170.2456 170.2 600.7331 466.3
© “ “ “ “" “"
[N —_ . . . « “ « “ “
+— M . : M . . .
5 H : . . N : : “« “« “« “« “«
Lﬁ “ “ “ “" “
 |Dryer A 1/3/2017 4:54:00 AM 113 594 167.147 196.4 547.8572 173.4
—
o Dryer B 1/3/2017 8:48:00 AM 93 0 169.3378 170.2 592.8909 4916 Dryer B Regneration 01-03-17 08:48 357.8753 399.4613 0.1699348 6347.083
E Dryer B 1/3/2017 8:54:00 AM 93 6 168.1517 1711 617.2303 490
© DryerB  1/3/2017 9:00:00 AM 9.3 12 167.7706 205.2 617.502 4887 “ “ “ “ “
LIL- _J “ “ “ “ “
- E : E E 5 E E “« “« “« “« “
OCJ . . . * . . “ “ “ “« «“
> “« « “
“ “
L —
OSlsoft.
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. L LA AR S
Diagnostic Analysis - Event Frame Evaluation

 Sampled Event View dataset
imported into Power Bl.

* Shows outlet temperature
profiles for all Event Frames
with filters for dryer asset and
cycle duration.

* Filter Event Frames to remove
outliers from analysis.

* Acceptable Regeneration cycle
durations between 7 and 17
hours.

0Slsoft.
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Dryer Regeneration - Additional Feature for Refinement

Determine if total barrels
of feed processed
during the Process cycle
prior to each
regeneration affects
outlet temperature
profile

4560 bbl. 6689 bbl. 5934 bbl. 3498 bbl.

Analysis in Power Bl

OSlsoft.
! PI World SAN FRANCISCO 2018 #0OSlIsoftUC  #PIWorld  ©2018 OSisoft, LLC



B YA AR S
Layers of Analytics — View Thru’ Multiple Lenses

, predictive, prescriptive

0OSlsoft.
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S . s /Y~ /A
Predictive and Prescriptive - Shape Metrics — Golden Run

= Dryer Regenerations txt £ |

1 hd Dryer TimeStamp.StartTime.Local TimeStamp.EndTime.Local TimeStamp.Local Duration ElapsedTime Dryer Pressure Outlet Temperature Rege
2 1 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:00:00 AM 5.3 0 170.4697 436.9 603.2525 496.1 Dryer A Regnerat
3 2 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:06:00 AM 5.3 ¢ 170.4824 437.8 603.6448 496.2 Dryer A Regnerat
4 3 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:12:00 AM 5.3 12 170.495 438.¢6 605.063 496.4 Dryer A Regneration 01-C
5 4 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:18:00 AM 5.3 18 170.507¢ 439.5 599.6411 496.8 Dryer A Regnerat
6 5 Dryer A 1/2/2017 12:00:00 AM 1/2/2017 5:18:00 AM 1/2/2017 12:24:00 AM 5.3 24 170.5202 440.3 ©04.8259 496.8 Dryer A Regnerat
76 e S Smn S Switwe 2 2 e a8 600.6193 496.2 Dryer A Regnerat
8 7 .04 497.2 Dryer A Regneration 01-C
9 8
10 9
S
12 11
13 12
14 13
15 14 400~
16 15
17 16
18 17
19 18
20 19
21 20
22 21 300~
23 22
24 23
25 24
26 25
27 26
28 27
29 28 200~
30 29
31 30
32 31
33 32
U 232

100 -

0 50 100 150 0 20 40 60
OSlsoft. Time Time
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92
600 - 450 -
93
95
400 -
10
400 -
(
w 510 12?1230 99@1' 350
= 1
2 3"69113 3 43 940C
815 28 60
715% 26 % 80 89 681 300-
200- 2 35
g5 ¥ 1
%2 Ege 10
3 53(55,%12‘;934 250-
55
0- 1 44 9097
0 50 1 200-
c(1:nrow(a1R
OSlsoft.
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Shape Metrics - Regen Cycles Not OK or Bad Data

Bad Data

450 -

as.factor(Cycle)
89
92

— 93

— 95

— 103

300 -

142

143
250 -

200 -

50

100
Time
#0OSlIsoftUC  #PIWorld
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Operationalize - Expected Temperature Profile (Prescriptive)

Via Future data tag

41972018 12:54:00 PM - 4/19/2018 3:54:00 PM

Event Type: DiyerProfile_OutlefT
Asset: WPISRVO1\Dryers\Dryer A

400 -

300 -

L L L L L
0.5h 8 . 2.5h
4/19/2018 12:54:00 PM 4/19/2018 3:54:00 PM

Time

é 7 osisoft
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Shape Metrics - Operationalize the Model

Score the real time Temperature profile data
is the Temperature profile as expected?
can the difference from ideal be stated quantitatively?
even if dissimilar, did we deliver enough energy?
what false alarms can | avoid?
after an alert, what corrective actions can | take?

‘ Add a new variable | iz iz > Functions
Name Expression Value at Evaluatio Value at Last Trigc  Output Attribute
Insert functions into the expression n
ShapeMeasurg IF 'Operating State'="Rege Map |
MATLAB

CurveFitting.calcCurveDistance

é 7 osisoft
! PI World SAN FRANCISCO 2018 #0OSIsoftUC  #PIWorld  ©2018 OSisoft, LLC



Shape Metrics - Operationalize the Model

Dryer A

|Genera| | Child Elements | Attributesl Ports ‘ Analyses ‘NDtiﬁcatiun Rules | Versinn‘

] =
e @ @ @
9= H
G = fa
o H
/] H
Q= fo
/] H
Add a new variable
Name
IdealData
MATLABEval

If (ArraylLengt
(CurrentData, ]

Deltak

DeltaAUC

~ (©) P Vision
@ Events

Message (ALY Te_

Automatically refresh the list

“dReply [
f|_—(} Reply All 55
(5 Forward g

< Top

X

: . Delete Archive

Root

@

Delete Respond

pismtprelay@gmail.cd
Dryer A generated a

The Outlet Temperature profile fi
12:54:00 PM Pacific Daylight Ti

Links:
Event Details Hyperlink
https://5000vlecs.cloudapp.net/

Scheduling: (e Event-

7 oslsoft
E‘S PlWorld san erancisco 2018

DryerProfile_OutletT 2018-04-19 12:54:00.000

Cause
4/19/2018 12:54:00 PM - 4119/2018 3:54:00 PM

O Edit Search Criteria

SIS
Root Cause

Event Type: DryerProfile_OutlefT
Asset: WPISRVOT\Dryers\Dryer A

411972018 12.54:.00 PM - 4/19/2018 3:54.00 PM

3 hours into the process

0.5h 1.0n 15h 2.0h 25h
411972018 12:54:00 PM 4/19/2018 3:54:00 PM
Trigger Attributes (2)

Dryer A Y| Start Value Y | End Value

Dryer A
DeltaAUC

Dryer A
DeltaE

Event Attributes (3)
Root Cause

#0OSlIsoftUC  #PIWorld
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B YA AR S
Layers of Analytics — View Thru’ Multiple Lenses

* Business Scope - Improved Reliability
« Usage-based Maintenance - UbM
« Condition-based Maintenance - CbM

 Predictive Maintenance — PdM
» Simple predictive (Advanced CbM)
» Advanced predictive - Statistical, Machine learning...

0OSlsoft.
PI WO rld SAN FRANCISCO 2018 #0OSIsoftUC  #PIWorld  ©2018 OSisoft, LLC 29



I L LA AR SN
Maintenance — Usage and Condition based

» Usage-based Maintenance - UbM
* Motor Run-hours
« Compressor starts/stops
« Transformer — Load Tap Changer — Counts of Operations, Count thru’ Neutral

« Condition-based Maintenance - CbM
* Delta P across afilter
* High bearing temperature
» High vibration

0OSlsoft.
PI WO rld SAN FRANCISCO 2018 #0OSIsoftUC  #PIWorld  ©2018 OSisoft, LLC 30



Maintenance — Usage based

Eile Search View Go JTools Help

@ Database [} Query Date - (0 @ Q@ Back () 8, Check In ¥} v 2] Refresh (J New Element - =] New Attribute

See Pl World 2018 CBM

Hand-on Lab

Elements Mixer 1
(% Elements ' General | Child Elements| Attril Ports | Analyses | Notification Rules | Version
|- @ Data Archive
% 1! Bxercise 1 Filter Name | Value
| [ € Process Area Mixer 1|Last Maintenance Date 3/26/2018 12:00:00 AM
- ﬂ Line 1 CabaL ] .
g 8 & ce M|Xer 1 Mixer 1|MTD Run Hours 55.643
L. Mixer 2
| - @ Line zlm 0w Mixer 1|Previous Day Run Hours 16.244
- (9 Exercise 2 o ] 5 09 Mixer 1|Run Hours Since Maintenance 14.827
(3, Element Searches |
. Mixer 1|Valve Actuation Count Since Maintenance 16
B <l Mixer 1]¥TD Run Hours 55.643
L]
[l
B =l ca Name Value Units Name Value Units
y o Mixer 1|Last Maintenance Date 3/26/2018 12:00:00 AM Mixer 1|Last Maintenance Date 3/23/2018 12:00:00 AM
- Mixer 1|MTD Run Hours 55.143 h Mixer 1|MTD Run Hours 7.5404 h
= Mixer 1|Previous Day Run Hours 16.244 h Mixer 1|Previous Day Run Hours 0 h
8 o Mixer 1|Run Hours Since Maintenant 14.327 h Mixer 1|Run Hours Since Maintenant 7.5484 h
" Mixer 1|Valve Actuation Count Since 16 count Mixer 1|Valve Actuation Count Since 62 count
B =l cate
e Name Value Units Name Value Units
L]
Mixer 2|Last Maintenance Date 3/25/2018 12:00:00 AM Mixer 2|Last Maintenance Date 3/24/2018 12:00:00 AM
L]
oo Mixer 2|MTD Run Hours 55.889 h Mixer 2|MTD Run Hours 7.4606 h
L] H
- o Mixer 2|Previous Day Run Hours 16.317 h Mixer 2|Previous Day Run Hours 0 h
o - R Mixer 2|Run Hours Since Maintenan« 30.733 h Mixer 2|Run Hours Since Maintenanc 7.4606 h
Mixer 2[Valve Actuation Count Since 34 count Mixer 2[Valve Actuation Count Since 53 count
0OSlsoft.

PIWorId SAN FRANCISCO 2018

#OSIsoftuC  #PIWorld
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Maintenance — Condition based See PI World 2018 CBM
Hand-on Lab

Eile Search VMiew Go Tools Help
a Database E Query Date -® G 0 Back ) hl( Check In ) « _ﬂ Refresh | @ New Element - -1 New Attribute

Elements

a Ex2-BearingTemperatureAlerts + Ad Hoc Display
=}- Elements
| |~ (3 Data Archive Number and Duration of High Bearing Temperature Alerts
| +- Exerd:
|1 o 1:!54!1 Assel Bearing Temperature|Alerts Count - 7 days  Bearing Temperature|Alerts Count - MTD  Bearing |Alerts Duration - 7 days ~ Bearing Duration - MTD ¥
| - ﬁ Exerdse 2 Pumpd1 320 110.0 152 h 268h
| = (3 Pump Station Pump4 370 1040 47h 2%60h
| |- & Pumpo1 Pumplz 80 98.0 121h 243h
| 1 & Pumpo2 Pump0s 300 900 123h 220h
| Pump03 230 97.0 97h 1960
I~ @ Pump03
{— 6 Pumpo4
E L & Pumpos Watchlist of High Bearing Temperature Alerts
— (£} Element Searches
Event Name | Asset A Start Time A End Time I Reason A By A Date L Acknowledgement
High Bearing Temp_2018-0 g
arasanen PUMPO4 3277201852500 AM 32772018 6:00:00 AM 4 _
High Bearing Temp_2018-0 . .
P PUMPO1 32712018 6:40:00 AM 32772018 7:15:00 AM I _
5 Elements N BeS P IE s PUMPO1 32712018 7:50.00 AM 32772018 8:30:00 AM I4 _
3-2T707-50:00
= Event Frames High Bearing Temp_2018.0
arorenon PUMP0Z 32712018 75000 AM 3272018 82500 AM 4 _
High Bearing Temp_2018-0 Y 4
e PUMPOS 32712018 90000 AM 32772018 94000 AM _
High Bearing Temp_2018.0
S BUMPO4 22712018500 00 AM 3272018 £:40.00 AM 4 _
High Bearing Temp_2018-0
e PUMPO3 32772018 9.40.00 AM 312712018 10.15.00 AM & _
High Bearing Temp_2018-0 :
e PUMPOZ 32772018 11:05:00 AM 372772018 11:30:00 AM 4 _
0Slsoft.
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NS, L LY ARR S
Maintenance — Predictive — RUL (remaining useful life)

»

% Full Scale
2 =3

“) oSlsoft
8‘& Pl\World san rrancisco 2018

w | See Pl World 2018 Layers
of Analytics Hand-on Lab

7/5/2018 8:24:25.795 AM
2528

Bearing Forecasted Failure Date
Bearing Life Expectancy

Name Expression Output Attribute
NatlLog if 'OverallBearingFault'>@ then Log('OverallBearingFault') else NoOutput() OverallBearingFault|Natural Log
Timel2back '*-12w'

a
/’%,& uLlnearRegr

if EnableFit then LinRegr('OverallBearingFault|Natural Log', Timel2back, '*',50) |

if BadVal(LinearRegr) Then NoOutput() Else LinearRegr

if EnableFit AND Not(Badval(LinearRegr)) then Convert(Fit[1]*24*36ee, "gE/day") e.

OverallBearingFault|m

b if EnableFit AND Not(BadVal(LinearRegr)) then Convert(Fit[2], "gE") else NoOutput |OverallBearingFaultlb
rsquared if EnableFit AND Not(BadvVal(LinearRegr)) then Convert(Fit[3],"ratio") else NoOutpi|OverallBearingFault]r squared
LifeExpectancy if EnableFit AND Not(BadVal(LinearRegr)) and m>@ and rsquared>.48@ then Convert((’|BearinglifeFxpectancy
ForecastedFailDate if EnableFit AND Not(BadVal(LinearRegr)) and m>® and rsquared>.48@ then TimeStamp |BearingForecastedFailureDate

#0OSlIsoftUC  #PIWorld
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B . AR SEARERY LSS
Predictive — Statistical, Machine Learning ...

Predict engine failure — Principal Components - TechCon 2016 | ink

100 engines, 20+ sensors per engine, aggregated data per cycle
~200 cycles of operation per engine
how long to failure?

Anomaly detection (HVAC - Air Handler) - Support Vectors - TechCon 2017 Link
7 sensors
~6 months of operations, 5 minute data
damper stuck open? temperature transmitter failed? air supply fan constraint?

Shape Metrics (profiles of operating variables) - Pl World 2018 Lab

OSlsoft.
! PI World SAN FRANCISCO 2018 #0OSIsoftUC  #PIWorld  ©2018 OSisoft, LLC


https://pisquare.osisoft.com/docs/DOC-3463-predicting-remaining-useful-life-and-equipment-failure-using-a-machine-learning-multivariate-model
https://pisquare.osisoft.com/groups/facilities/blog/2018/01/04/data-sciencemachine-learning-use-case-with-hvac-air-handler

B YA AR S
Layers of Analytics — View Thru’ Multiple Lenses

* Functional Scope - Process Insight & Excellence
» Descriptive, diagnostic, predictive, prescriptive

- Business Scope - |mproved Reliability
» Usage-based Maintenance - UbM

* Condition-based Maintenance - CbM

» Predictive Maintenance — PdM
» Simple predictive (Advanced CbM)
* Advanced predictive - Statistical, Machine learning...

« Architectural Location
* Edge device, Server or cloud based
« Analytics during data collection? (National Instruments, InsightCM)

0OSlsoft.
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OSlsoft Virtual Learning Environment

° ACCeSS to th e h an dS_O n IabS d eve I O ped fo r th e past OSIsoft Home  Technical Support Pl Square Community  Live Library Welcome, Curt Hertler  Sign ol :

two Users Conferences (~40)
* Pl Products
* Pl System Development
+ Condition Based Maintenance
* Analytics with PI System Data

* Hosted Pl System on the Microsoft Azure Cloud

Asset Based Pl Example Kits Manual

Field Service Scripts Manual

nthly or Yearly Subscription P g

. . . TechCon 2016: Administering and Managing the Pl Server Manual
ailable to all customers via credit card payment

b TechCon 2016: Advanced Pl Web API Manual

' o EA CUStomers and Dev CIUb Members TechCon 2016: Advanced Programming with Pl AF SDK Manual

TechCon 2016: Build Better Reports with PI SQL Framework Manual

t D TechCon 2016: Build Web-Based Real-Time Dashboards Manual

O m e r e m OS TechCen 2016: Collecting Data using the new Pl Connector for UFL Manual

ess for OT and Data Science (IT?) O ——

TechCon 2016: Developing Cross-platform Mobile Apps Using Apache Cordova and Pl Web API Manual

TechCon 2016: Downtime Analysis with Event Frames Manual

TechCen 2016: Operational Insights Using Real-time Dashboards and Self-service Business Manual

7~ | OSlsoft.

> PIWorld san rrancisco 2018

@ OSlsoit. Learning
My Registrations Virtual Learning Classroom Training Online Courses
Environment
QOverview

My Subscription My Session

?Caﬂ(Empty)

click cartto procsed to checkout

YouTube Learning
Channel

Yearly

Intelligence

#0OSIsoftuC  #PIWorld
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Thank You

* Gopal GopalKrishnan, P.E.
* Gopal@osisoft.com

e Solution Architect
* OSlsoft, LLC

e Curt Hertler

* Curt@osisoft.com

* Principal Technical Advisor
¢ * OSlsoft, LLC

0OSlsoft.
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Questions

Please wait for the
microphone before asking
your qguestions 2

State your ;
name & company

OSlsoft.

PI WOI’|C| SAN FRANCISCO 2018

Please remember to...

Complete the Online Survey
for this session

Download the Cor* App for
2017

search OSISOFT in the app store
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Mercli iﬁj iﬁﬂ
Danke

Cnacumnbo Gracias
. Thank You
AL C} HOOMNES
Grazie Obrigado
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